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What is Workshare Professional

Workshare Professional reimagines multi-party review and collaboration and ensures the
safe and accurate exchange of information, enabling the collaborative evolution of high
value business documents.

Workshare Professional is a desktop application that automates managing changes to
business documents, protects against unauthorized content disclosure and delivers the
world’s most secure PDF creation, all in one integrated solution.

Key features of Workshare Professional include:

Comparison of Word, PowerPoint, Excel and PDF files, including image-based
PDF files

Comparison of selected pieces of content, such as a single paragraph or clause
Ability to accept/reject in a comparison and then create new documents

Advanced comparison features including one-to-many comparisons (Word and
PDF files), version comparisons, and access from within Office and Document
Management Systems

Access to comparison functionality from within Outlook as well as right-click access
from within individual emails

Conversion from PDF to DOC format for local files and from within the DMS/CRM

Advanced, interactive metadata cleaning/PDF creation/secure file transfer for
attachments in Outlook

Comprehensive content risk protection enabling the discovery and removal of
hidden sensitive data as well as visible sensitive data

Options to save and share Office documents to Workshare online
Access and visibility into online collaborative workspaces directly from Office

Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

Centralized policy design and enforcement administrator tools
ECM/DMS and OCR integration with desktop comparison features
Centralized user account management and control

Complete access to Workshare online functionality to share and collaborate on
documents, including setting folder access and permissions, positional commenting
and reviewer communications with presence indicators

Desktop sync app to synchronize your online content to your local desktop
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Note: Workshare Professional can be installed without Microsoft Office integration. In this
case, the comparison functionality is only available from the Workshare comparison
applications and the metadata removal functionality is only available when sending
emails.

What’s New in Workshare Professional 10.3

The Professional 10.3 release includes the following:
+ Rendering sets in Compare for Excel

Rendering sets affect what changes are detected as well as how changes are
displayed. Compare for Excel includes two default rendering sets or you may
create your own.
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A rendering set is selected before running a comparison. A different rendering set
can also be applied after the comparison has been run and new rendering sets
created using options in the Compare for Excel ribbon.
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o Access to Workshare’s comparison functionality from the Litera ribbon

If configured, the Compare and Selective Compare options (Compare group) are
added to the Litera ribbon in Microsoft Office (Word, Excel, PowerPoint and
Outlook). Users can then launch Workshare’s comparison functionality from the
Litera toolbar.
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This is configured using the Add the Workshare Compare group to the Litera
Desktop ribbon in Microsoft Office parameter in the General > User Interface
category in the Workshare Configuration Manager.

o Assorted bug fixes

System Requirements

The recommended system requirements for Workshare Professional 10.3 are:
e Intel Core i3 @ 2.5GHz
e AMD Athlon 64 X4
e 4GB RAM

Workshare Professional 10.3 has a 32-bit version for 32-bit Microsoft Office environments
and a 64-bit version for 64-bit Office environments.



Workshare Professional 10.3 Release Notes

Certified Environments for Workshare Professional 10.3
(32-bit version)

Workshare Professional 10.3 (32-bit version) has been tested and certified in a number of
environments. If your environment is not included in the following list, it may still be a
compatible environment. Contact Workshare Customer Support
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us
language set.

Operating System:

e Microsoft Windows 10 (32 bit and 64 bit)

e Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

o Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French
Citrix:

e With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

o Citrix XenApp 7.5
o Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports
your version of Citrix.

Microsoft Office System:
o Microsoft Office 365 (desktop)
o Microsoft Office 2019 (32 bit) — including click-to-run
o Microsoft Office 2016 (32 bit) — including click-to-run
» Microsoft Office 2013 SP1 (32 bit) + Japanese — including click-to-run

Email System:
e Microsoft Outlook 365 (desktop)
e Microsoft Outlook 2019 (32 bit)
e Microsoft Outlook 2016 (32 bit)
e Microsoft Outlook 2013 SP1 (32 bit) + Japanese
e IBM Notes 9.0.1 FP7, FP8 and FP9
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Note: Interactive Protect and the replace email attachment with link features of
Workshare are not supported in a Notes environment.

Browsers:
e Microsoft Edge, latest version
e Microsoft Internet Explorer 11
o Google Chrome, latest version
e Mozilla Firefox, latest version
Microsoft SharePoint:
e Microsoft SharePoint 2013 SP1

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports
your DMS.

¢ NetDocuments
ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send
to application functionality, Microsoft Internet Explorer must be installed
(although it does not have to be the default browser).

» iManage clients:
o FileSite/DeskSite 9.0 Update 6 and above
= Work 10 Desktop for Windows 10.0 and above

= Work 10 web client (You will need to install Workshare iManage Integration
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

o OpenText:
= eDOCS DM 16.5
= eDOCS DM 10
= eDOCS DM 5.3.1 COM only (Patch 6)

o Worldox:
= GX4

Workshare will endeavor to support future service packs of certified environments.
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Certified Environments for Workshare Professional 10.3
(64-bit version)

Workshare Professional 10.3 (64-bit version) has been tested and certified in a number of
environments. If your environment is not included in the following list, it may still be a
compatible environment. Contact Workshare Customer Support
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us
language set.

Operating System:
e Microsoft Windows 10 (64 bit)
Citrix:
o  With Microsoft Windows Server 2012 R2 (64 bit)

o Citrix XenApp 7.5
o Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports
your version of Citrix.

Microsoft Office System:

o Microsoft Office 365 (desktop) (64 bit)
e Microsoft Office 2019 (64 bit)
e Microsoft Office 2016 (64 bit)

o Microsoft Office 2013 SP1 (64 bit)

Email System:

o Microsoft Outlook 365 (desktop) (64 bit)
e Microsoft Outlook 2019 (64 bit)
e Microsoft Outlook 2016 (64 bit)

e Microsoft Outlook 2013 SP1 (64 bit)
Browsers:

e Microsoft Edge, latest version

o Microsoft Internet Explorer 11

o Google Chrome, latest version
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o Mozilla Firefox, latest version

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports
your DMS.

¢ NetDocuments
ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send
to application functionality, Microsoft Internet Explorer must be installed
(although it does not have to be the default browser).

» iManage clients:
o FileSite/DeskSite 9.3 (64 bit) and above
= Work 10 Desktop for Windows 10.0 (64 bit) and above

= Work 10 web client (You will need to install Workshare iManage Integration
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

e OpenText:
= eDOCS DM 16.5
= eDOCS DM 10

Workshare will endeavor to support future service packs of certified environments.

Important Information

Secure PDFs — Workshare Professional is unable to compare secure PDFs or convert
secure PDFs to Word format. Secure PDFs are PDF files with security settings configured.

POP/IMAP — Workshare Professional does not support Outlook when it is configured with
a POP or IMAP account.

Important installation information

o Workshare Professional installs program files to a sub-folder within the Workshare
folder named Modules.
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o Install: A user is unable to install Workshare Professional if Microsoft Windows
Installer 3.1 is not installed. This can be downloaded from the following location
https://www.microsoft.com/en-us/download/details.aspx?id=25.

e Windows 7: When UAC is set to Default, running the Workshare Professional
install displays the UAC prompt. You must approve the prompt and Workshare
Professional will be installed. Running the Workshare Professional MSI silently will
fail when UAC is set to Default because the user is not given the opportunity to
approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly
recommend that you first uninstall them before installing Workshare Professional 10.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release
- for more information, please contact Customer Support.

Ref
PRO-3239
PRO-3690

PRO-3711

PRO-3751

PRO-3765

PRO-3787

PRO-3790

PRO-3804

PRO-3863

PRO-3918

PRO-3919

CR
01167599

01040245

01152714

01171909

Description
iManage test connection fails in WCM (Admin Mode)

Save as' dialog doesn't appear in focus when saving
PowerPoint Comparison to the server from 'Create’ button

Compare for PPT - Workshare PDF Publisher is always
listed as default in Print Comparison Report dialog

Default print size changes to 'Legal’ for documents that use
a section break to switch to 'Landscape' layout

Compare for Excel - changes made in the exported file are
not reflected in the document and also the version is not
updated when user relaunches the document from
NetDocuments.

WCM Admin option is show as modified at start, when no
options have been modified

Changes made in the exported file are not reflected to the
document and also the version is not updated when user
relaunches the document from iManage

Workshare crashing when comparing certain Excel files

Failed to run 'Convert to Track Changes' error dialog is
displayed when switching modes of the comparison.

File extension is appended to resultant redline (Word)
document name when comparing supported documents.

Help application is not launched when user clicks on 'Help'
button from the Compare for Excel ribbon.

10
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Ref
PRO-3949

PRO-4056

PRO-4119

PRO-4165

PRO-4181

PRO-4238

PRO-4256

PRO-4291

PRO-621

Workshare Professional 10.3 Release Notes

CR Description

Output Filename' dialog is displayed when user performs
print action and then cancels the print action from the Print
dialog for the second time.

01173864 Compare does not retrieve the latest saved version of a
document when comparing files from iManage Work 10
using the MRU list.

Modified document view in TER is displayed distorted when
saving/Printing as PDF and swapping the documents.

Export' button is not functional on comparison window,
when comparing certain Excel documents.

When performing 'Attach/relate to Original (or) Modified'
action, no document is displayed under Related documents
tab.

Error dialog, "the Comparison couldn't be performed' You
could try re-saving..." is displayed, when comparing certain
Excel files with deleted 'Overlaid Objects'.

01175276 Documents remains checked-out when saving a
comparison as attached/related to the Original/Modified
document in Work 10 (.docx only)

No documents is displayed under Related documents tab
when performing Attach/Relate to the Original/Modified
Presentation action from PowerPoint.

01120989 Selecting convert to PDF for the 'Save as related document'
option titles the file with the Doc ID instead of file name.

Known Issues

The following are known issues in the Workshare Professional 10.3 release - for more
information, please contact Customer Support.

Ref

PRO-4466
01176343

PRO-4250
01174274

PRO-4049
01173819

Description

Compare for Excel: Documents using Simplified Chinese have redlines
incorrectly showing as all modified or deleted.

Compare only populates the modified field with an Appdata file path when
selecting the 'Save and Sync' option from the iManage tab in Word.

A .NET framework error occurs when launching Outlook if Workshare
Professional is not licensed.
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Ref

PRO-3843
01171983

PRO-3753
01170892

PRO-3709
01169986

PRO-3689
01172368

PRO-3449
01168494

PRO-3409
01168025

PRO-3137
01166593

PRO-2812
01164429

PRO-2609
01163333

PRO-2513

PRO-2342
01161036

PRO-1387

PRO-1386

PRO-1019

PRO-837
01061816
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Description

Document specific: Specific Word documents are taking 3-5 minutes to
compare.

Unable to select certain cells after running Excel comparison.

Document specific: Compare for Excel hangs when comparing specific
spreadsheets.

When Nuance PDF is the default printer, a Okb file is generated when
printing a redline from Workshare Compare.

The error "System.Threading. ThreadAbortException" may be displayed
when saving a redline as attach/relate to original/modified document in
OpenText DM 16.5.

iManage integration: After an upgrade, the recent files list in Compare’s
Document Selection dialog retains the recent files compared prior to the
upgrade. However, you are not able to compare those recent iManage files
because the path is shown as “interwovenSite://...” rather than
“‘iManage://...".

When cleaning metadata from a PowerPoint attachment with the lightspeed
clean option enabled, the slide animation sequence may be removed.

Document specific: Compare for Excel hangs when comparing a specific
sheet in a workbook.

Links in Excel documents are detected again even after removal.

Errors can occur when using Selective Compare if Compare dialogs are
open and the "Launch new comparison in running instance" configuration
option is enabled.

Replies to comments in Word are detached when the lightspeed clean
option is enabled.

Compare for Excel: Changes may not be indicated correctly when
comparing spreadsheets with a deleted/inserted column when the first row is
empty.

Compare for Excel: Merged cells are displayed as individual cells when the
merged cell is not in full view on the comparison window.

Compare for Excel: Focus is not completely applied to the last change in the
comparison window if the user clicks the Last Change button for the first
time.

After running a comparison in Workshare Compare, the right aligned text in
the footer may move to become center-aligned.
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Ref Description

PRO-815  Combine PDF is not picking up changes made to an open iManage

01062255 | document even after saving it. The workaround is to close the saved
document and reopen it before using the Combine PDF functionality.

PRO-792 | After running a comparison in Workshare Compare, some line numbering

01088791 | and table text and row cells maybe be missing.

PRO-528  IBM Notes 9.0.1 FP7 only. Attachments are duplicated in sent items when
the email is processed through desktop profiles or all mail profiles. This is an
issue with IBM Notes.

PRO-527 | IBM Notes only. Attachments are not automatically compressed to a zip file
when the limit specified in the WCM is reached.

PRO-525 | The positioning of signature components in RTF format emails can be
incorrect after processing with Protect.

PRO-109 | The error ‘Failed to compare documents. Unable to convert documents.’ is

01099537 | displayed when comparing specific scanned PDF documents.

PRO-22 The Reset Layout option is missing from the Quick Access Toolbar
drop-down in Compare for PowerPoint.

01012100 | The account or company name is not displayed in File > Help > About in
Workshare Compare.

01018577 | Worldox document footer stamps are not updated when saving a
comparison via Save As in Workshare Compare.

01018743 | The font in the email body changes to Times New Roman when sending
attachments to groups in Interactive Protect.

01028440 | Editing a rendering set on the fly does not prompt to save as a new set or
overwrite the current rendering set.

40418 When comparing particular presentations, 'Index was outside the bounds of
the array' error is displayed.

40430 When comparing presentations and at least one has the Opulent design
theme applied, a ‘Color is not resolved yet’ error is displayed.

40469 In Compare for PowerPoint, a newly created comparison theme does not
appear in the Select dropdown in the Home ribbon (Comparison Themes
group).

40574 A user is not automatically logged into Professional after logging into the

desktop app first (64-bit version only).
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Ref Description

40597 The local file store dialog is displayed when browsing for files from the
desktop app when a DMS is set as the default (64-bit version only).

41284 In Compare for PowerPoint, comparisons of DMS files are not listed in the
recent comparison list (File > Open > Recent).

41547 When a PowerPoint presentation is run from the command line, the incorrect
comparison theme is highlighted under the Select dropdown in the Home
ribbon.

45583 When a machine is restarted before the convert to link process has

completed, files which are not synced are moved to a conflict state in the
desktop app.

Contact Info

For technical help and support on Workshare products, contact Workshare Customer

Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090
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& Workshare Ltd.
© 2019. Workshare Ltd. All rights reserved.

Copyright

Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare,
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and
that trademarks are used only for editorial purposes.

Disclaimer

The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated help
from time to time. The authors would like to assure users of their continued best efforts in supplying the most effective
help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions

Published for Workshare Professional 10.0: 18/12/18; minor revisions: 17/1/19 & 15/2/19
Revised for Workshare Professional 10.1: 27/3/19

Revised for Workshare Professional 10.1 Revision 1: 16/5/19

Revised for Workshare Professional 10.2: 28/6/19

Revised for Workshare Professional 10.2 Revision 1: 19/8/19

Revised for Workshare Professional 10.3: 2/10/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com
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